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Object Oriented Programming Course (CEID_NNY106) 

Εργαστηριακή Άσκηση 
Πρόσθεση 2 αριθμών με χρήση στοίβας (Add2Numbers)  

 
 

1. Στόχος  
 

Εξοικείωση με:  

• το BlueJ, 
• τη συγγραφή και εκτέλεση java εφαρμογής, 

• τις βασικές έννοιες του αντικειμενοστρεφούς παραδείγματος προγραμματισμού, 
• την βασική βιβλιοθήκη της Java (Java API) 

https://docs.oracle.com/javase/8/docs/api/. 

 
 

Πρόσθεση 2 αριθμών με χρήση στοίβας 
 

H Εργαστηριακή Άσκηση (ΕΑ) έχει ως στόχο την εξοικείωση με πολύ βασικές έννοιες της 
αντικειμενοστρεφούς προσέγγισης στην ανάπτυξη λογισμικού και πιο συγκεκριμένα με τις 

έννοιες της κλάσης και του στιγμιότυπου και του τρόπου που αυτά χρησιμοποιούνται για 
την ανάπτυξη προγράμματος. 
 

H ΕΑ βασίζεται στις Δραστηριότητες 4.2 – 4.7 του κεφαλαίου 4 του βιβλίου “Από τις 
Υπολογιστικές στις Κυβερνο-Φυσικές Διεργασίες και το IoT: Αντικείμενα και Υπηρεσίες”, 

Κ. Θραμπουλίδης, ISBN 978-960-418-961-8,  2022, ΕΚΔΟΣΕΙΣ Α. ΤΖΙΟΛΑ & ΥΙΟΙ Α.Ε. 
https://sites.google.com/view/fromcomputationaltocyber-physi/home 

 

Η ΕΑ περιλαμβάνει ένα σύνολο από Δράσεις που είναι απαραίτητες πριν την συγγραφή 
κώδικα. Οι Δράσεις αυτές είναι μέρος του κεφαλαίου 3.  

 

 

2. Πρόγραμμα πρόσθεσης 2 αριθμών με χρήση στοίβας (Add2Numbers) 
 

Αναπτύξτε ένα πρόγραμμα σε Java σύμφωνα με το οποίο το σύστημα: 

 
1. θα δημιουργεί δύο στιγμιότυπα της Double με δεδομένες τιμές,  

2. θα δημιουργεί ένα στιγμιότυπο στοίβας για αποθήκευση αριθμών κινητής 

υποδιαστολής διπλής ακρίβειας, 

3. θα βάζει τα δύο στιγμιότυπα της Double που έχει δημιουργήσει στην στοίβα, 

4. θα τα βγάζει από την στοίβα, 

5. θα βρίσκει το άθροισμα τους, 

6. θα βάζει το άθροισμα στην στοίβα, 

7. τέλος θα βγάζει το άθροισμα από την στοίβα και θα το εμφανίζει στον χρήστη. 

 

 

https://docs.oracle.com/javase/8/docs/api/
https://sites.google.com/view/fromcomputationaltocyber-physi/home
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3. Οδηγίες εκτέλεσης 
 
Πριν από την ανάπτυξη του προγράμματος Add2Numbers θα πρέπει να εκτελέσετε ένα 

σύνολο από Δράσεις με τη σειρά που σας δίνονται παρακάτω: 
 

1. Εγκατάσταση του JDK. 

2. Εγκατάσταση του BlueJ. 

3. Χρήση κλάσεων της βασικής βιβλιοθήκης της Java μέσα από το BlueJ. 

4. Χρήση μεθόδου κλάσης και μεθόδου στιγμιότυπου. 

5. Συγγραφή και εκτέλεση προγράμματος “Hello world!” 

 
Οι δράσεις 1 και 2 πρέπει να εκτελεστούν οπωσδήποτε για να μπορείτε να πάτε στις 

επόμενες. Τις δράσεις 3 έως και 5 πρέπει να είστε σε θέση να τις εκτελέσετε καθώς έγιναν 
κατά την διάρκεια των διαλέξεων.  

 
Μετά την ολοκλήρωση των δράσεων 1-5 θα είστε σε θέση να προχωρήσετε στην ανάπτυξη 
του προγράμματος Add2Numbers.  

 
Αξιοποιήσετε την επικοινωνία με τους συμφοιτητές σας και τους διδάσκοντες για 

να ξεπεράσετε τα δύσκολα στην κατανόηση ή εκτέλεση σημεία της ΕΑ.  
 

3.1 Δράση Νο 1: Εγκατάσταση του JDK 

Tο Java Development Kit (JDK) είναι το περιβάλλον που σας επιτρέπει να αναπτύξετε και 
να εκτελέσετε προγράμματα με βάση το αντικειμενοστρεφές παράδειγμα 

προγραμματισμού με χρήση της γλώσσας προγραμματισμού Java.  
 
Μεταξύ των εργαλείων που υποστηρίζουν τη διαδικασία ανάπτυξης προγράμματος είναι:  

 
A) O javac, ο οποίος είναι ο μεταγλωττιστής της Java (java compiler), που σας 

επιτρέπει να μετατρέψετε τον πηγαίο κώδικα σε μορφή Java bytecodes, και, 
 

B) Ο java, ο οποίος είναι o διερμηνευτής της Java (Java interpreter), που σας 

επιτρέπει να εκτελέσετε το αρχείο bytecodes που δημιουργήσατε με τον javac. 
 

3.2 Δράση Νο 2: Εγκατάσταση του BlueJ 

 

Το BlueJ είναι ένα περιβάλλον που αρχικά σχεδιάστηκε για εκπαιδευτικούς λόγους, στη 
συνέχεια όμως εξελίχθηκε σε IDE. Είναι κατάλληλο για αρχάριους καθώς βοηθάει πολύ 

στην κατανόηση των βασικών εννοιών, δίνοντας τη δυνατότητα άμεσης 
αλληλεπίδρασης του προγραμματιστή με τα συνθετικά του προγράμματός του 

κατά τη δημιουργία και τον έλεγχό τους. 
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3.3 Δράση Νο 3: Χρήση κλάσεων της βασικής βιβλιοθήκης της Java μέσα από το 
BlueJ 

 

Πρόσθεση 2 στιγμιότυπων της Double με χρήση της στοίβας. 
 

Χρησιμοποιήστε το BlueJ για να εκτελέσετε τις παρακάτω ενέργειες 
 

1) Δημιουργήστε ένα project στο BlueJ με όνομα MyFirstProject.  

 
• Επιλέξτε Project->New Project 

 
• Στο παράθυρο που θα εμφανιστεί επιλέξτε ως Location το ευρετήριο στο 

οποίο θέλετε να τοποθετήσετε το project σας και δώστε του όνομα 

MyFirstProject. Επιλέξτε ΟΚ. To project σας θα τοποθετηθεί σε ευρετήριο με 
το όνομα του project κάτω από το ευρετήριο που ορίσατε ως Location. 

 

 
 

2) Από την επιλογή Tools-> Use Library Class πληκτρολογήστε το όνομα της κλάσης 
Double και ENTER. 

 

 
 

3) Επιλέξτε τον δημιουργό (constructor) Double(double), ορίστε ως όνομα του 

στιγμιότυπου το d1 και δώστε την τιμή του για να δημιουργήσετε με τον τρόπο 
αυτό ένα στιγμιότυπο της κλάσης Double στο οποίο θα αναφέρεστε με την αναφορά 
d1. 
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Στο κάτω μέρος της οθόνης του BlueJ θα δείτε ένα εικονίδιο. Αυτό σας δίνει τη 
δυνατότητα επικοινωνίας με το στιγμιότυπο που μόλις δημιουργήθηκε. 

 

 
  

4) Δημιουργήστε ακόμη ένα στιγμιότυπο με όνομα d2. Επιλέξτε τώρα τον δημιουργό  

Double(String). 
 

 
 
Θα εμφανιστεί το εικονίδιο του d2 όπως παρακάτω. 

 

 
 

  
5) Αξιοποιήστε τώρα την κλάση Stack για να δημιουργήσετε ένα στιγμιότυπο στοίβας. 

Για τον προσδιορισμό της πρέπει να δώσετε το πλήρες προσδιοριστικό  της 
(identifier) που είναι java.util.Stack. Θα δείτε πως υπάρχει μόνο ένας δημιουργός 

όπως δείχνει η εικόνα παρακάτω. 
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Επιλέξτε τον. Θα χρειαστεί να δώσετε, εκτός από το όνομα του στιγμιότυπου (θα 

του δώσουμε όνομα st1) και τον τύπο των στιγμιότυπων που θα βάζετε μέσα. 
Καθώς εμείς θέλουμε να βάζουμε αναφορές τύπου Double δώστε το Double ως 
Type Parameter όπως φαίνεται παρακάτω.  

 

 
 

Έχετε δημιουργήσει ένα στιγμιότυπο στοίβας με αναφορά (όνομα) st1.  
Έχετε τώρα τρία στιγμιότυπα, δύο, τα d1 και d2, της κλάσης Double και ένα, το 
st1, της κλάσης Stack. 

   

 
 
Στο στιγμιότυπο της στοίβας μπορείτε να βάλετε μόνο αναφορές τύπου Double.  

 
6) Βάλτε στην στοίβα το d1. Δεξί κλικ στο εικονίδιο του st1 και επιλέξτε push.  

 
 



KLEANTHIS THRAMBOULIDIS 6 OOP COURSE – LAB_EXERCISE ADD2NUMBERS 

 

Με την ενέργεια σας αυτή έχετε καλέσει την μέθοδο στιγμιότυπου push με 
αποτέλεσμα να δείτε την παρακάτω εικόνα.  

 
Δώστε ως όρισμα στην μέθοδο push την αναφορά d1 και επιλέξτε οκ.  Θα δείτε την 
παρακάτω εικόνα η οποία σας δείχνει την επιστρεφόμενη τιμή της μεθόδου push η 

οποία είναι αναφορά σε στιγμιότυπο τύπου Double.  
 

 
 
Επιλέξτε Inspect και θα δείτε την τιμή του στιγμιοτύπου που μόλις βάλατε στην 

στοίβα. 
 

 
 
Κλείστε τα 2 παράθυρα επιλέγοντας close και επαναλάβατε την ίδια διαδικασία για 

να βάλετε στην στοίβα και το στιγμιότυπο d2. 
 

7) Ελέγξτε αν τα d1 και d2 έχουν τοποθετηθεί στην στοίβα σας. 
Διπλό κλικ πάνω στο εικονίδιο του st1. Θα δείτε πως η στοίβα σας περιέχει 2 

στοιχεία. Η πληροφορία αυτή είναι η τιμή της μεταβλητής elementCount που είναι 
τύπου int και είναι protected (θα το δούμε αυτό αργότερα). 

 
Επιλέξτε Inspect και θα δείτε τα περιεχόμενα της στοίβας όπως παρακάτω. 
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Η εικόνα δείχνει πως η στοίβα st1 έχει ως στοιχεία δύο αναφορές. Μας δείχνει 

επίσης και τον αριθμό των στοιχείων που μπορεί να δεχθεί στην τρέχουσα 
κατάσταση της η στοίβα st1. Μπορείτε να δείτε πως τα στοιχεία [2]-[9] περιέχουν 

null. To null είναι δεσμευμένη λέξη της Java και χρησιμοποιείται για να προσδιορίσει 
την τιμή μιας αναφοράς που δεν δείχνει σε κανένα στιγμιότυπο. 
Επιλέξτε το 2ο στοιχείο, δηλαδή το [1], και στη συνέχεια Inspect. 

Θα δείτε (εικόνα παρακάτω) πως 2ο στοιχείο της στοίβας είναι αυτό που βάλατε 
τελευταίο, δηλαδή το στιγμιότυπο με τιμή 24.5.  

 

 
  
Κλείστε τα τρία παράθυρα και επιστρέψτε στην οθόνη του BlueJ.  
 

8) Πάρτε από την στοίβα st1 ένα στοιχείο καλώντας την μέθοδο pop. Επιλέξτε το st1, 
δεξί κλικ και pop() για να πάρετε από την στοίβα ένα στοιχείο. H pop σας επιστρέφει 

μια αναφορά σε στιγμιότυπο τύπου Double όπως φαίνεται παρακάτω.  

 
 

Επιλέξτε Get για να πάρετε την αναφορά αυτή και να την αποθηκεύσετε σε μία νέα 
μεταβλητή αναφοράς. Την μεταβλητή αυτή την ονομάζουμε d3 όπως φαίνεται στην 

εικόνα παρακάτω.  
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Επιλέξτε ΟΚ. Στην οθόνη θα δείτε το εικονίδιο της αναφοράς d3. 
 

 
 

Κλείστε το παράθυρο της pop και ελέγξτε πόσα στοιχεία έχει η στοίβα σας. Θα δείτε 
πως έχει τώρα ένα στοιχείο, την αναφορά του στιγμιότυπου που κάνατε push στην 

αρχή.  
 
Διπλό κλικ πάνω στην αναφορά d2 και θα δείτε την τιμή του στιγμιότυπου στο 

οποίο αυτή δείχνει. Είναι το στιγμιότυπο με τιμή 24.5. Διπλό κλικ πάνω στην 
αναφορά d3 και θα δείτε την τιμή του στιγμιότυπου στο οποίο αυτή δείχνει. Είναι 

το στιγμιότυπο με τιμή 24.5. Έχουμε δηλαδή τώρα δύο αναφορές τις d2 και d3 που 
δείχνουν στο ίδιο στιγμιότυπο, αυτό που δημιουργήσαμε με τιμή 24.5. 
 

 
 

9) Πάρτε από την στοίβα και το άλλο στοιχείο και αναθέστε το σε αναφορά με όνομα 

d4. 

 
 

10) Βάλτε στην στοίβα το άθροισμα των αριθμών που βγάλατε παραπάνω δηλαδή των 

d3, d4. Επιλέξτε την st1 και push. Δώστε ως  όρισμα στην push την έκφραση d3 
+ d4.  
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Επιλέξτε οκ.  
Η push επιστρέφει μια αναφορά σε στιγμιότυπο Double, το οποίο είναι το 

στιγμιότυπο που δημιουργήθηκε ως αποτέλεσμα της εκτέλεσης της πράξης της 
πρόσθεσης πάνω στις αναφορές d3 και d4. 

 

 
 

Επιλέξτε Close. Λογικά η στοίβα σας τώρα θα πρέπει να έχει ένα στοιχείο. Αυτό 
είναι η αναφορά στο στιγμιότυπο που δημιουργήθηκε από την πρόσθεση των d3, 

d4. 
 

11) Ελέγξτε αν αυτό έχει γίνει. 

 
12) Πάρτε έναν αριθμό από την στοίβα. Αυτός πρέπει να είναι το άθροισμα των d1 και 

d2. 
 

Το πρόγραμμα που σας ζητείται να αναπτύξετε στην ΕΑ είναι αυτό που θα αναθέτει στη 
μηχανή να κάνει αυτά που εσείς κάνατε μέσα από τη γραφική διεπαφή του BlueJ. Είναι 

μια αυτοματοποίηση της διαδικασίας που εκτελέσατε μέσα από αυτές τις τρείς Δράσεις. 
 

3.4 Δράση Νο 4: Χρήση μεθόδου κλάσης και μεθόδου στιγμιότυπου 

 
Από την επιλογή Tools -> use library class του BlueJ χρησιμοποιήστε την κλάση Double 
για να συγκρίνετε δύο αριθμούς κινητής υποδιαστολής.  

 
1. Κάντε τη σύγκριση αξιοποιώντας τη μέθοδο κλάσης compare() 

 

static int compare(double d1, double d2) 

 

2. Κάντε τη σύγκριση αξιοποιώντας τη μέθοδο στιγμιότυπου compareTo() 
 

int compareTo(Double anotherDouble) 

 

Δοκιμάστε να αξιοποιήσετε και άλλες κλασεις της βασικής βιβλιοθήκης, όπως Integer, 

String, StringBuffer. 
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Μετά την ολοκλήρωση της ΕΑ μπορείτε να γράψετε ένα πρόγραμμα που θα αναθέτει στη 
μηχανή να κάνει αυτά που εσείς κάνατε παραπάνω μέσα από τη γραφική διεπαφή του 

BlueJ. 
 
 

3.5 Δράση Νο 5: Συγγραφή και εκτέλεση προγράμματος “Hello world!” 

 

Το πρόγραμμα HelloWorld 

 
1. Δημιουργήστε ένα project στο BlueJ με όνομα HelloWorld. Επιλέξτε  

 
Project->New Project 
 

Στο παράθυρο που θα εμφανιστεί επιλέξτε ως Location το ευρετήριο στο οποίο θέλετε 
να τοποθετήσετε το project σας και δώστε του όνομα HelloWorld.  

 

 
 

Επιλέξτε ΟΚ. To project σας θα τοποθετηθεί σε ευρετήριο με το όνομα του project 
κάτω από το ευρετήριο που ορίσατε ως Location. 
 

 
2. Επιλέξτε New Class για να ορίσετε την κλάση που αναπαριστά το πρόγραμμα σας. 

Δώστε της όνομα HelloWorld και επιλέξτε ΟΚ.  
 

 
 

Tο BlueJ δημιουργεί την κλάση την οποία θα δείτε στην οθόνη σας όπως παρακάτω. 
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3. Επιλέξτε την κλάση και με δεξί κλικ επιλέξτε Open Editor. Στην οθόνη θα δείτε τον 

πηγαίο κώδικα που σας δίνει έτοιμο για την κλάση σας το BlueJ.  
 

 
 

4. Για το project μας διαγράφουμε όλο το σώμα της κλάσης και δίνουμε ως σώμα της 
κλάσης μόνο την μέθοδο main() και προαιρετικά μια μεταβλητή κλάσης όπως κάναμε 

στην διάλεξη ή αυτό που θα βρείτε στο web.  
 

static String message = “Hello World!”;  

 

Η main() προσδιορίζει την συμπεριφορά του προγράμματος σας όταν θα το τρέξετε. Η 

εικόνα παρακάτω δίνει μια εκδοχή του προγράμματος HelloWorld με χρήση της 
μεταβλητής κλάσης (class data member) message. 
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5. Μεταγλωττίστε (από την επιλογή compile του editor) και στη συνέχεια τρέξτε το 
πρόγραμμα σας επιλέγοντας την κλάση HelloWorld, δεξί κλικ και επιλέγετε void 

main().  
 

 
 

Δεν δίνετε ορίσματα γραμμής διαταγών. Επιλέξτε ΟΚ. 
 
Αν όλα πήγαν καλά θα εκτελεστεί η main() και θα σας τυπώσει στο terminal το μήνυμα 

“HelloWorld!” ή όποιο έχετε εσείς ορίσει. 
 

 
 
Προσέξτε πως η main() είναι δηλωμένη ως μέθοδος κλάσης (keyword static) και ότι η 

μεταβλητή (data member) message ως μεταβλητή κλάσης (keyword static). 
 

3.6 Δράση Νο 6 – Ανάπτυξη προγράμματος Add2Numbers  

 
Θα χρησιμοποιήσετε το BlueJ για να αναπτύξετε και να τρέξετε το πρόγραμμα 

Add2Numbers. Θα χρησιμοποιήσετε την κλάση java.util.Stack 

 
Δημιουργήστε ένα project στο BlueJ με όνομα Add2Numbers. 

Δημιουργήστε μια κλάση με όνομα Add2Numbers. Αυτή θα είναι και η μόνη κλάση του 
προγράμματος σας. 

 
Ορίστε την μέθοδο main ώστε να υλοποιεί την συμπεριφορά που σας ζητά η ΕΑ, αυτην 
δηλαδή που περιγράφει η ενότητα 2. Τον κώδικα αναπτύξαμε (ή θα αναπτύξουμε) βήμα 

προς βήμα κατά τη διάρκεια της διάλεξης. 
 

Εκτελέστε το πρόγραμμα στο BlueJ για να ελέγξετε την λειτουργικότητα του.  
 
Q1: Ποιες επιλογές έχετε στην δήλωση των αναφορών στιγμιότυπων; 
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4. Δράση No 7 - Πρόγραμμα σύγκρισης δύο αριθμών κινητής 
υποδιαστολής 

 
Αν ολοκληρώσατε την πρώτη έκδοση της βασικής άσκησης, σας συνιστούμε να εκτελέσετε 
την παρακάτω προαιρετική Άσκηση, η οποία έχει άμεση σχέση με την ενέργεια Νο 4. 

 
Γράψτε ένα πρόγραμμα στο BlueJ σύμφωνα με το οποίο το σύστημα θα συγκρίνει δύο 

δεδομένους αριθμούς κινητής υποδιαστολής, πρώτα χρησιμοποιώντας μέθοδο κλάσης της 
Double και στη συνέχεια χρησιμοποιώντας μέθοδο στιγμιότυπου της ίδιας κλάσης. Στη 
συνέχεια θα ενημερώνει το χρήστη για το αποτέλεσμα της σύγκρισης.  
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